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Modul ini menyajikan mengenai pengoperasiannya dalam software EViews.
Modul ini dilengkapi dengan langkah-langkah praktis dalam mengoperasikan
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Oleh : Mansuri

1 Pendahuluan
1.1 Apa itu EViews?

Eviews (Econometric Views) merupakan aplikasi pengolahan data statistika dan
ekonometrika yang berjalan diatas sistem Operasi Windows. Kita dapat
menggunakan eviews untuk melakukan analisis cross section dan panel data serta
melakukan estimasi dan peramalan data time series. Meskipun ditujukan untuk
pengolahan data ekonomi, tetapi kemampuan Eviews tidak terbatas pada area
ekonomi, eviews dapat digunakan untuk analisis keuangan, peramalan
makroekonomi, simulasi, peramalan penjualan hingga analisis biaya

Eviews dikembangkan oleh Quantitative Micro Software (QMS). Piranti lunak yang
dikembangkan awalnya bernama T7ime Series Processor untuk komputer
mainframe, kemudian QMS mengembangkan MicroTSP yang dapat dijalankan di
PC yang pertama kali di rilis pada tahun 19801. Eviews versi 1.0 dirilis pada bulan
maret 1994 menggantikan MicroTSP. Versi terbaru eviews, versi 9.5 dirilis pada

bulan 8 Mei 2015.
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Eviews memiliki format data yang tidak memiliki dokumentasi terbuka tetapi

mendukung format data aplikasi lain baik untuk masukan(input) maupun keluaran

(output). Beberapa format file yang didukung eviews diantaranya :

databank format, merupakan format file data time series ekonometrika dalam
bentuk ASCII yang dipopulerkan oleh microTSP

Microsoft Excel

SPSS / PSPP

DAP/SAS

STATA

RATS

TSP, dsb

Selain format data diatas, Eviews juga dapat membaca database lewat ODBC.

Lingkungan Kerja Eviews

Lingkungan Kerja atau workspace eviews cukup sederhana. Berikut gambar

lingkungan kerja Eviews.

[ Title

% EViews - o x
Main Menu —> e et Object View Proc Quick Options Add-ins Windew Help

Command __
Window

Work Area ——>

Welcome to EViews Path = ctemp | DB = test | WF = none
Note: Path/Database/Workfile /,—/7 / T

can be changed by double-clicking in each. ~ Path/directory  Database Workfile
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Keterangan:

Title Bar, default hanya bertuliskan Eviews, kalau anda memperbesar ukuran salah
satu jendela di work area, maka nama file akan tertulis di title bar.

Main Menu, berisi menu yang dapat kita pilih. Beberapa menu akan berwarna
abu-abu dan tidak aktif sehingga kita tidak dapat memilih menu tersebut. Misal
ketika kita belum membuka workfile, maka menu object akan banyak yang tidak

aktif seperti gambar berikut.
Object | View Proc Quick

New Object...

Fetch from DE...
Update... Ctrl+F5
Store to DB...

Copy Object...

MName...

Delete

Freeze Output
Print Ctrl+P

View Options r
Hal ini juga berlaku terhadap object lain. ketika kita memilih sebuah objek (table,
rumus, dsb) ketika sebuah menu tidak aktif artinya kita tidak dapat melakukan

operasi tersebut pada objek bersangkutan.

command window, di command window ini, kita dapat mengetikkan perintah-
perintah yang langsung akan dieksekusi oleh eviews. Kalau ingin mencoba, anda
bisa mengetikkan perintah load, maka jendela pilihan file akan muncul.

work area, merupakan area terbesar yang berwarna abu-abu. disinilah letak
workfile yang kita buka baik berupa tabel maupun objek lainnya.

status bar, status bar berisi informasi tentang path yaitu direktori kerja kita saat ini,

Database yang kita gunakan (DB), dan workfile yang sedang kita gunakan (WF).
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Untuk mengubah path atau direktori kerja kita sekarang, kita bisa melakukan klik
ganda pada tulisan path di status bar, akan muncul dialog box yang memberikan
pilihan kepada kita kemana akan mengalihkan direktori kerja kita di eviews. Sekian
Tutorial Eviews Episode 1, pada Episode selanjutnya kita akan belajar membuka
workfile, membuat workfile, dan mengimport file dari aplikasi lain (excel misalnya)

ke Eviews.

1.2 Menggunakan EViews

Untuk menggunakan EViews langkah-langkah yang harus lakukan adalah melalui
klik menu Start > All Apps > EViews 9 > EViews 9 atau melalui lkon yang ada di
desktop. Dengan menjalankan perintah tersebut akan ditampilkan lingkungan

sistem EViews seperti terlihat pada Gambar di bawah ini.

| ¥ Eviews - O X
File Edit Object View Proc Quick Options Add-ins Window Help

|
Command I Capture |

Gambar 1: Desktop Eviews
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A. Membuat Workfile, Input data dan Impor Data

Memasukkan data ke Eviews, bisa dengan membuat tabel baru di Eviews atau
melakukan import dari data aplikasi lain, seperti file excel misalnya. Tapi apa itu
workfile? workfile merupakan tempat mengumpulkan objek yang akan kita
gunakan di eviews. objek disini dapat berupa tabel, perhitungan(equation), grafik,
sample dan lain sebagainya. Setiap workfile dapat berisi satu atau lebih workfile
pages, bayangkan seperti file excel yang dapat memiliki lebih dari satu worksheet,
fungsi pages ini seperti subfolder atau subdirektori yang berfungsi untuk
mengumpulkan objek yang kita miliki. Terdapat dua metode utama untuk
melakukan input data di Eviews. Metode pertama dengan membuat file kosong,
mendefinisikan struktur data yang kita miliki dan melakukan input data dengan
mengetikkan data satu persatu atau melakukan kopi tempel (copy paste). Metode

kedua yaitu dengan melakukan impor data dari file lain seperti file Excel.

1. Membuat Workfile:

Untuk membuat Workfile, Pilih menu File = New = Workfile seperti gambar

berikut:

¥ Eviews

File | Edit Object View Proc Quick Options Add-ins Window Help
Mew 4 Workfile... Ctrl+M
Open 4 Database...
Save Ctrl+5 Prograrm
Save As... Text File
Close
Irmport 3
Export 3
Print Ctrl+P
Print Setup...
Run... F10
Exit
0 data expor-importadsx
1 ddlamatbu wah..\bu_ani_interpolasiwfi

Akan tampil window Workfile Create Disini bisa didefinisikan Struktur data,

apakah Unstructured / Undated,Dated — Regular Frequency, atau Balanced
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Panel. Secara sederhana apabila yang dimiliki merupkan data runtun waktu
pilihan workfile structure type adalah Dated — Regular Frequency, apabila data
yang dimiliki adalah data panel maka pilihannya pada Balance Panel dan bila

data merupakan data primer maka gunakan Unstructured / Undated.

Workfile Create x Workfile Create x
Workfile structure type Date specification Workfile structure type Date spedification
Dated - regular frequency Frequency: | Annual e 2 Dated - regular frequency  ~ Frequency: | Annual e
Unstructured / Undated Mulhfylﬁar
Dated - reqgular frequer Annual
Irregular Dated and Panel -

Balanced Panel Start date: e ey s e e Start date: Si“;';”r:"”a‘
Unstructured workfiles by later . Unstructured workfiles by later .

o End date: End date:
specifying date and/or other spedfying date and/or other Bimonthl
identifier series. identifier series. Fnrm\ghzy

Ten-day (Trimanthly)
\ieekly
Daily - 5 day week

Workfile names (optional) Workfile names {optional) Daily - 7 day week
WF: WF: Daily - custom week
Intraday
Page: Page: Integer date
Cancel Cancel ‘

Tiga item yang perlu mendapat perhatian dalam membuat workfile. Contoh
kasus akan dibuat workfile menggunakan data time series, maka yang harus
diperhatikan adalah:

1 . Workfile structure type - Dated-regular frekuency

2 : Date specification = Monthly

3 : Start date : waktu awal periode dan End date : akhir periode

Contoh

Date spedification
Frequency:  Monthly V

Start date: |2012:5
End date:  |2016:5|

Akan tampil Workfile baru dengan nama UNTITLED, karena secara default
Eviews pemberian nama pada workfile Eviews adalah untilited yang selanjutnya

bias diubah sesuai dengan kehendak pengguna.
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Workfile: UMTITLED E@

[View]Prc-c]Dbject] [SE\re]FreezeIDetails+f-] [ShowlFetchlStoreIDeleteIGenrlSample]

Range: 2012M05 2016M05 — 49 obs Filter: *
Sample: 2012M05 2016M05 — 49 obs Crder: Mame
—=

E] c

Y resid

< 3% Untitled | New Page /

Sampai disini proses pembuatan workfile telah selesai dan untuk menyimpan
lakukan perintah untuk menyimpan workfile yaitu klik File dan Pilih Save As

atau Save selanjutnya berinama dan Simpan.

Setelah workfile selesai dibuat selanjutnya adalah memasukkan data kedalam
Eviews. Terdapat dua cara input data pertama dengan cara manual (satu
persatu, atau dapat dilakukan dengan Copy Paste dari file data yang sudah
tersedia) dan kedua dengan cara menimpor dari file Ms. Exel yang telah berisi

data yang akan dilakukan analisis.

Cara Pertama:

» Klik menu object pada workfile, pilih New Object...
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MNew Object...

Generate Series...

Fetch from DB...
Update selected...

Ctrl+F3

Store selected to DE...

Manage Links & Formulae...

Rename selected...

Delete selected

Print Selected

» Pilih Series pada Type of Series, beri nama missal: ekspor, akan tampil

spreadsheet baru tempat data akan dimasukkan

I Mew Object

5 Type of object
H

3 Series

Factor ~
Graph

Group

LogL
Matrix-Vector-Coef
Model

Pool

Sample

Scalar

Series Link
Series Alpha
Spool
SSpace
String
SWVector
System
Table

Text
ValMap

VAR
UserObj b

Mame for object

ekspor]|

Cancel

» Sebelum menginput data klik tombol edit +/-. Kemudian memasukkan data

satu per satu untuk tiap periode atau jika data sudah tersedia bisa copy

paste.

Contoh disini adalah data ekspor yang bersumber dari Bank Indonesia

mulai Mei 2012 sampai dengan Mei 2016.

Berikut adalah langkah untuk mempastekan dari data yang telah tersedia:
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kA Series: EKSPOR  Worldile: UNTITLED:Untitled\,

[\-’iewl Proc[ Dbject] Pmperties] [Printl Name] Freeze] Default

(o &S]

~ | | Sort | Edit+/- | Smpl+

EKSPOR

2012M05
2012M06
2012M07
2012M08
2012M09
2012M10
2012M11
2012m2
2013M01
2013M02
2013M03
2013M04
2013M05
2013M06
2013M07
2013M08
2013M09

Pada gambar di atas seluruh data terlihat belum terisi, untuk mempastekan

2013M10 | €

A
MNA
A
MNA

A
MNA
A
A
MNA
A
MNA
A
A
MNA

A

Last updated: 07/26/16 - 20:57

Tampilan objek dari ekspor

langkahnya adalah klik tombol Edit+/-

FA Series: EKSPOR  Workfile: UNTITLED:Untitled) == S
[\u"iewlProcIObjectIPropertiesl [PrintINamelFreeze] Diefault ~ | |Sort|Edit+/-| Smpl=
| | EKSPOR
| | |
Last updated: 07/26/16 - 20:57 -
2012M05 el
2012M06 I Copy Ctrl+C
_2012M07_| I Paste Ctrl+V
2012M08 | .
" op12M0g | I Paste Special...
2012M10 I .
To012MA1 | | Display format...
2012m12 | Clear Contents
_2013M01 | I Insert obs...
2013M02 |
" o013M03 | I Delete obs...
2013M04 I
W I Select all
_ 2013MOE | I Edit +/-
2013M07 I Sample +/-
2013M08 |
2013M09 (I Label=l v
2013M10 Wide+/- 2
ObslD +/-
< » Untitled | New P Title...
Save table to disk... P
a
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Setelah dipaste terlihat seperti berikut:

bA Series: EKSPOR  Workdfile: UNTITLED:: Untitled, = =l |t
[UiewlPrncIDbjectIPmperties] [PrintINamelFreeze] Default et [SGrtIEditﬂ-IEmpl-i
| EKSPOR

I | | I

Last updated: 07/26/16 - 21:01 ~

201205 16829545550 |

2012KM06 15441457938
2012807 16090595299
2012808 14047007385
2012809 15898115717
2012810 15324042715
2012M11 16316911273
2012M12 15393946390
2013M01 15375487902

2013M02 15015627735
201303 15024577683
2013M04 14760892129
201305 16133358194

2013M06 14758319151

201307 15087863565

2013M08 13083707039

2013M09 14706775080 v
2013mM10 | € &

Sampai disini proses input data selesai.dan workfile dapat disimpan. Secara
default, Eviews akan menyimpan File ke Directory My Document, jika anda
ingin menyimpannya ke tempat lain maka lakukan penyimpanan dengan

mengklik File Save As, lalu pilih Direktori Baru yang anda inginkan.

Cara kedua yaitu Impor dari File Ms. Ecel, Sebelumnya siapkan data atau
melakukan tabulasi

Klik Proc = Import = Import from file
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Workfile: UNTITLED E\@

View Prochbject] [Sa\reIFreezeIDetails-'-f—l [Show FetchIStorelDeleteIGeanSample]

Rang Set Sample... Filter: *
Sam| Order: Mame

Structure/Resize Current Page...
Append to Current Page...
Contract Current Page...

T BT Y

Reshape Current Page 3

ERIRIRIWE

Copy/Extract from Current Page 3
Sort Current Page...

Load Worlkfile Page ...
Save Current Page ...
Rename Current Page ...

Delete Current Page

Import 3 Load Workfile Page...

Export 3 Import from file...

Table from file...
Matrix from file...
Fetch from DE...
< 3! Untitled | New Page / TSD File Import...

| DRl Basic Economics Database...

[0 om

Gambar : Langkah Import Data

l ¥ Open X |
T @ » ThisPC » Documents » v O Search Documents 2
[
Organize v New folder = O @
~ - o |
| [ ThisPC Mame Type |
I Desktop FIK-UNBOR File folder
= GomPlayer /2016 11:17 PM File folder
@ Documents
IBM /2016 11:17PM  File folder
Download
¥ Downloads LyxDocument 719/2016 8:15PM  File folder
B Music My Palettes 7/12/2016 :45PM  File folder
=] Pictures =} My Shapes 7/1/2016 11:17PM  File folder
m Videos OneNote MNotebooks /2016 11:17 PM File folder
= i . Pengabdian Masyarakat 7/24/2016 919 PM  File folder
i Local Disk (C) g sy
= Cadangan (D) PHPMaker 712/2016 00 PM  File folder
Visual Studie 2010 7/23/2016 1:19 PM File folder
- Data (E:)
i Data Expor-Import.xlsx 7/25/2016 8:05 PM Microsoft Office |
o0 DVD Drive (F:) V¢
rive (F) 7 EViews Example Files 7/23/2016 1:49 PM Shortcut w
= Removable Disk , o >
Browse Location: || gcal Computer o
FE /D ata Expor-Import.xdsx ~ | Excel file (*xlsx: *xlsm) w

[ Update default directory Cancel
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Pilih data yang akan diimport dari file Excel yang sudah dibuat.

Excel Read - Step 1 of 3 *
Cell Range
(®) Predefined range Sheet: nekspor e
=
nekspar e
| Start cell: | SASL H @
=]
O Custom range —
nekspor! SAS1:5C550 End cell: &CE50 A W
=
periode| ekspor| Cadangan Dewvisag Y
2012:5 18825545550 1115285
2012:5] 15441457538 10&502
2012:7| 15090535253 10&555
2012:-38| 14047007385 10845350
2012:-9 15838115717 110172
2012:10] 15324042715 110257
2012:11) 16316911273 111285
2012:12] 1535933453530 112781
2013:1] 153754873902 108780 W
[(read series by row (transpose incoming data)
Cancel <Back Next> | | Finish
Excel Read - Step 2 of 3 >

Column info
Click in preview to select column for editing

Column headers
Name: periode

Header lines:

Description:
Clear Edited Column Info
Text representing MA
ED Data type: |pate v
ekspor Cadangan Dewvisa
AhleRacl 16825545550 111528 A
chleiae 15441457938 108502
bt 1609055952599 108555
kiR 14047007385 108930
pAahleRg=l 15898115717 110172
sl 15324042715 110257
PLNEREN 16316511273 111285
elihleile) 153935946350 112781 o

[JRead series by row (transpose incoming data)

Cancel | |

<Back [ Mext> | | Finish
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Excel Read - Step 3 of 3 *

Import method Struchre of the Data to be Imported
Dated read V Basic structure

Dated - spedfied by date series Monthly
Import options

Identifier series
Rename Series

Date series: | periode
Freguency Conversion

DERICDE EESPOR CADANGAN DEVISL
2012M05 2012M05 1_6BE+10 1115285 ”~
2012M08 Z012M0g 1_54E+10 106502
2012M07 2012M07 1_&81E+10 108555
2012M08 Z012M0B 1_40E+10 108590|
2012M03 Z012M05 1_55E+10 110172
2012M10 Z012M10 1_53E+10 1102597
2012M11 2012M11 1_&83E+10 111285
2012M12 Z012M12 1_54E+10) 112781
2013M01 2013M01 1.54E+10 lose7a0| W
201 aMAT

Cancel <Back Mext>

Dan klik Finish, dan klik No pada pernyataan link imported series and alpha

objeck to external source ?
Sampai disini proses memasukan data dengan cara impor selesai.

Untuk melihat apakah data sudah dapat digunakan dalam pengolahan data

maka dapat dilakukan langkah-langkah berikut:

Dari Workfile blok semua variable dan kemudian klik kanan mouse pilih as

Group. Berikut adalah gambar dalam proses membuat group dalam Eviews:
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Workfile: CONTOH EVIEWS - (e2\2016\mydata\contoh eviewswfl) | = || = |[5]

[‘ufiewl Procl Object] [Sa\relFreezeIDetails-e-f—] [ShowlFetchlStoreIDeletel Genr]Samplel

Range: 20002015 — 16 obs
Sample: 2000 2015 — 16 obs

Filter. *
Order: Name

[B] c
B eks
kA hrg
B4 kurs
kA resid

<> Untiied [ U

Open

Preview F9
Copy Ctrl+C
Copy Special...

Paste Ctrl+V
Paste Special...

Fetch from DB...
Update... Ctrl+F5
Store to DB...

Export to file...
Manage Links & Formulae...

Rename...

Delete

3

as Group

as Equation...

as Factor...

as VAR..

as System...

as Multiple series

Maka Eviews akan menampilkan dataset seperti terlihat pada

berikut:

[

(G Group: UNTITLED Workfile: CONTOH EVIEWS::... | = || B |[s23m

[ViewlPrncIDbject] [PrintINamelFreeze Default w | | Sort | Edit+/-|!
EKS | HRG KURS |

2000 3678.8 248 48 5.B5 ~
2001 4065.3 33148 10.23
2002 84314 G41.88 13.50
2003 15718.0 100.80 13.84
2004 11881.0 536.69 12 66
2005 93487 33225 13.98
2006 14561.0 657 .60 15.69
2007 20148.0 9228.10 16.62
2008 26776.0 1085.50 18.96
2009 43501.0 1912.20 22.05
2010 48223.0 243580 2250
2011 G5076.0 G936.70 20.60
2012 54941.0 7314 43.00
2012 58087.0 2107.70 T0.67
2014 112871.0 283570 71.20
2015 108280.0 3235.80 a4.00

W

< >

gambar
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B. Statistik Deskriptif

Statistik Deskriptif adalah analisis paling sederhana dalam statistic. Untuk
melakukan analisis statistic deskriptif langkah yang harus dilakukan adalah:

Dari menu Quick = Group Statistik = Deskriptive Statistics - Commond
sample.

Proc | Quick | Options  Add-ins  Window Help
Sample...

Generate Series...

’_ Show ...

Graph ...
[ e SIS orkfile: CONTOH EVIEWS - (e:2016\mydata\contoh eviewswd1) [ = || =[]
Series Statistics » o[ Proc| Object | [ save [Freeze [ Details~/-| [ show| Fetch | store | Delete [ Genr [ sample
Group Statistics 3 Descriptive Statistics 3 Common sample Filter: *
Estimate Equation... Covariances Individual samples M
Estimate VAR... Correlations

[ Cross Correlogram

% Johansen Cointegration Test

£ Granger C li

ger Causality Test
[l

< »\_Untitled }, Untitled1 { New Page /

Akan tampil windows berikut:

Series List ot

List of series, groups, and/or series expressions

EAnam roa car ror

Cancel

Masukan variable yang akan di tampilkan pada analisis Deskriptif dan klik

tombol OK.
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Maka akan menghasilkan :

(6] Group: UNTITLED Workfile: CONTOH EVIEWS:Untitled 1, = (=] ﬁ|
[View[ProcIDbject] [PrinthameIFreeze] [SampIEISheetIStatSISpec]
SAHAM | ROA | CAR | ROR |
Mean 30.52188 13.87938 17.893656 15.52156 -
Median 2490000 13.57000 1718000 14.89000
Maximum G6.40000 19.37000 31.85000 2018000
Minimum 5700000 8.600000 10.01000 10.22000
Std. Dev. 2151243 2474801 4. 6904949 2842948
Skewness 0.255438 0158022 1.057462 0.038346
Kurtosis 1.389093 2688823 4. 608028 1.969226
Jarque-Bera 3765196 0262287 9415830 1.424501
Probability 0152194 0877092 0.009024 0.4805349
2um 9767000 444 1400 573.9700 496 6900
Sum Sq. Dey. 14346.33 189.8792 6820243 250.5530
Observations 32 3z 32 3z

Untuk menyimpan klik tab Name di atas selanjutnya berinama dan klik tombol

OK.
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C. Estimasi Model

Anggap data sudah tersedia maka estimasi model untuk selanjutnya bisa
dilakukan.

Langkahnya :

Klik Quick | Estimate Equation | sehingga muncul kotak dialog sebagai
berikut :

Equaticn Estimation >
Spedfication  Options
Egquation specification

Dependent variable followed by list of regressors induding ARMA
and POL terms, OR an explicit equation like ¥ =c{1)+c(2)®X,

Estimation settings

Method: |5 - Least Sguares (MLS and ARMA) e

sample: [ 5000 2015

Cancel

Masukan Model yang akan diestimasi ke dalam kotak dialog “equation
specification”, sebagai berikut :

Penulisan persamaan di Eviews hanya variabelnya saja yang dipisahkan
dengan spasi. Variabel yang diketikan paling awal dibaca Eviews sebagai
variabel dependen. Kemudlian C = a.
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Equation Estimation
Spedification  Options
Egquation specification

Dependent variable followed by list of regressors induding ARMA
and POL terms, OR an explidt equation like ¥ =c{1)+c(Z)®X.

eks c hrg kurs|

Estimation settings

Method: || 5 - |east Squares (MLS and ARMA) w

sample: [ 5000 2015

Cancel

Klik Ok sehingga dihasilkan estimasi regresi sebagai berikut :
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(=] Equation: UNTITLED Workfile: CONTOH EVIEWS:Latihan\, | = || & |[s23s]
[‘JiewlecIDbject] [PrinthameIFreezE] [EstimatEIFnrecastIStatsIResids]

Dependent Variable: EKS
Method: Least Squares
Date: 081116 Time: 15:47
Sample: 2000 2015
Included observations: 16

Yariable Coefficient Std. Error t-Statistic Prob.

c -4067. 496 4584 454  -0.887237 0.3911

HRG 7.815037 1.818575 4297340 0.0009

KURS 1001.855 130.3073 7.688406 0.0000
R-squared 0.911347 Mean dependentvar I7o13m
Adjusted R-squared 0.897709 3S.D. dependentvar 3494941
S.E. of regression 11177.88  Akaike info criterion 21.64862
Sum squared resid 1.62E+09 Schwarz criterion 21.79348
Log likelihood -170.1880  Hannan-Cluinn criter. 21.65604
F-statistic G6.81992 Durbin-\Watson stat 2161663

Prob(F-statistic) 0.000000

Klik View | Pilih Representation | sehingga diperoleh fungsi persamaan
sebagai berikut :

[=] Equation: UNTITLED Waorkfile: CON1
[View[P‘rnchbject] [P‘rintINamelFreeze

Representations

Estimation Output

Actual, Fitted, Residual »
ARMA Structure...

Akan ditampilkan hasil persamaan seperti terlihat berikut ini:
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[=] Equation: UNTITLED Workfile: COMTOH EVIEWS:Latihan, | = || =] ||&|

[‘u‘iewIPrncIDbjectl [F‘rintINamEIFreezE] [EstimateanrecastlStatslﬂesids]
Estimation Command:

L3 EKS C HRG KURS

Estimation Equation:

EKS = C(1) + C(2PHRG + C{3"*KURS

Substituted Coefficients:

EKS =-4067.49594743 + 7.81803732617*HRG + 1001.8585457 9" KURS

Dependent Yariable: EKS
Method: Least Squares
Date: 081116 Time: 15:47
Sample: 2000 2015
Included observations: 16

Variable Coefficient Std. Error t-Statistic Praob.

c -4067 496 4584 454  -0.887237 0.2811

HRG T7.815037 1.818575 4297340 0.0009

KLURS 1001.855 1303073 7.688408 0.0000
R-zquared 0.911347 Mean dependent var 3791301
Adjusted R-squared 0897709 S.D. dependentvar 34849 .41
S.E. of regression 11177.88  Akaike info criterian 21.64862
3um squared resid 1.62E+09 Schwarz criterion 21.78348
Log likelinood -170.1890 Hannan-Qwinn criter. 21.65604
F-statistic 66.81992 Durbin-Watson stat 2161663

Prob(F-statistic) 0.000000

Jika hasil diatas ditulis dihasilkan persamaaan sebagai berikut :

EKS = -4067.49594743 + 7.81503732617*HRG + 1001.8554579*KURS

Selanjutnya Klik Name untuk menyimpan persamaan | beri nama :
persamaan
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Contoh Kasus Analisis Regresi Linier
Berganda dan Penyelesaiannya

Regresi Linier Berganda yang akan disajikan pada contoh kasus ini
menggunakan pendekatan Ordinary Least Squares (OLS). Penjelasan akan
dibagi menjadi 4 (empat) tahapan, yaitu:

a. Persiapan Data (Tabulasi Data)

b. Estimasi Model Regresi Linier (Berganda)

c. Pengujian Asumsi Klasik

d. Uji Kelayakan Model (Goodness of Fit Model

e. Intepretasi Model Regresi Linier (Berganda)

Persiapan data dimaksudkan untuk melakukan input data ke dalam software
EViews. Setelah data di-input kedalam software EViews, maka langkah
selanjutnya adalah melakukan estimasi (pendugaan) model (persamaan) regresi
linier, baru dilanjutkan dengan pengujian asumsi klasik. Pengujian asumsi klasik
dilakukan setelah model regresi diestimasi, bukan sebelum model diestimasi.
Tidak mungkin pengujian asumsi klasik dilakukan sebelum model regresi
diestimasi, karena pengujian asumsi klasik yang meliputi normalitas,
heteroskedastisitas dan autokorelasi membutuhkan data residual model yang
didapat setelah model terbentuk. Apabila model yang terbentuk tidak
memenuhi  asumsi  klasik  yang  disyaratkan, maka  dibutuhkan
modifikasi/transformasi/penyembuhan terhadap data ataupun model regresi.
Pada bagian ini akan dibahas solusi yang harus ditempuh apabila tidak
dipenuhinya asumsi  klasik dalam model regresi linier, terutama

heteroskedastisitas. Tahap terakhir dari bagian ini akan dijelaskan bagaimana
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melihat layak tidaknya model dan menginterpretasikan model yang terbentuk.
Berikut rincian tahap-tahap yang dilakukan dalam regresi linier berganda :

1. Persipapan Data (Tabulasi Data)

Sebagai pendahuluan dalam proses pengolahan data adalah
mempersiapkan data. Data yang digunakan pada contoh berikut ini adalah
data time series bersifat fiktif. dengan dimensi waktu/periode yang panjang.
Satuan waktu dari data disesuaikan dengan data yang dimiliki, misalnya
bulanan, triwulan, semesteran, atau tahunan.

Berikut ini adalah contoh data Ekspor Garment dari Indonesia ke Jepang.
Data yang tersedia dalam tahunan, 2000 - 2015. Adapun variabel
penelitiannya adalah Ekspor Garment, dalam ton (EKS) sebagai variabel
terikat (dependent variable). Harga Ekspor Garment, dalam juta per ton
(HRG) dan Kurs Yen terhadap Rupiah (KURS) sebagai variabel bebas
(/independent variable). Contoh ini ingin melihat pengaruh variabel Harga
Ekspor Garment (HRG) dan variabel Kurs Yen terhadap Rupiah (KURS)
terhadap variabel Ekspor Garment (EKS), sehingga model regresi yang

terbentuk sebagai berikut :

EKS:a"‘ﬁ[X] -/-ﬁgXZ + &

Model tersebut di atas akan diestimasi adalah parameter koefisien regresi
dan konstanta, yaitu nilai 8/ (/= 0, 1, 2). Guna mengestimasi persamaan dari
model di atas dengan software EViews, maka data yang dimiliki harus

disusun dalam format seperti terlihat di bawah ini :

TAHUN EKS HRG KURS
2000 3678.80 | 248.48 5.65
2001 4065.30 | 331.48 10.23
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2002 8431.40 | 641.88 13.50
2003 15718.00 | 100.80 13.84
2004 11891.00 | 536.69 12.66
2005 9349.70 | 332.25 13.98
2006 14561.00 | 657.60 15.69
2007 20148.00 | 928.10 16.62
2008 26776.00 | 1085.50 18.96
2009 43501.00 | 1912.20 | 22.05
2010 49223.00 | 2435.80 | 22.50
2011 65076.00 | 6936.70 | 20.60
2012 54941.00 | 3173.14 | 43.00
2013 58097.00 | 2107.70 | 70.67
2014 | 112871.00 | 2935.70 | 71.20
2015 | 108280.00 | 3235.80 | 84.00

Data di atas dapat dibuat dalam file Excel. Setelah data siap, maka
penginputan data dalam software EViews dapat dilakukan dengan cara yang
telah dijelaskan di atas. Dalam contoh ini akan menjelaskan dengan cara
Copy-Paste secara menyeluruh. Hal ini ditujukan untuk memperkaya para

praktikum dalam proses memasukan data ke workfile Eviews. Berikut

langkah yang harus dilakukan:
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Hame Insert Page Layout Farm

= X cut

_5| Times Mew Roman ~ 12 -
Paste A

- anrmatF‘ainter LA A e e

Clipboard ] Font
Al - Je | TAHUN
A B C b}

1 |TAHUN EKS HRG | KURS
2| 2000 3678 B0l 24848 565
3 2001 406530| 33148 10.23
4 | 2002 8431.40| 64188 13.50
5 | 2003 15718.00 10080 13 84
6 | 2004 1189100 53669 12.66
7| 2005 934970 33225 1398
g | 2006 1456100 65760 15.69
9 | 2007 20148001 928.10 1662
10| 2008 26776.00| 108550 18.96
SR I Ty Ty s} 42801 nnl 1012 20 NS

Blok data yang ada dalam Ms. Exel, selanjutnya dari menu Home klik Copy
atau dengan menekan tombol CTRL+C. Selanjutnya pada workfile Eviews

yang telah dipersiapkan klik menu Edit > Paste Spesial. Seperti gambar

berikut:
¥4 Eviews
File | Edit | Object View Proc Qui
Comt Undo Ctrl+Z [_
Cut Ctri+X
-DC Copy CtrieC |
— Copy Special... o
Paste Ctrl+V
Paste Special...
Delete
Find... Ctrl+F
Replace... Ctri+R
Mext F3
Insert Text File...
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Akan ditampilkan Windows seperti berikut:

Paste Special

Select a dipboard format to paste

ot

Text

Excel Binary Format

Ok

|| Cancel

Pilih Exel Binary Format dan klik OK

Column headers

Header lines: El

Excel 97-2003 Clipboard Read - Step 1 of 2

Column info
Click in preview to select column for editing

Mame: TAHUN
Header type: |Names only w
Description:
Clear Edited Column Info
Text representing MA
B Data type: | Number v
EES HEEZ ERS
3878.8| Z48_.48| 5.85
4085.3| 331.48 10.23
8431 .4 <41.88 13.5
15718 100.8| 13.84
11851 53e.c53 12 _cq|
9345_7| 332_25 13.38
14581 e57.8] 15.85
20143 9Z28.1] 1e.82

[C]read series by row {transpose incoming data)

Cancel <gack [ Next> | | Finish
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Klik Finis Untuk selesai proses Copy-Paste, Selanjutnya Blok semua Variabel
untuk membuat group pada kondisi terblok klik kanan dan pilih open = as
Group.

Langkahnya seperti terlihat pada gambar berikut:

Workfile: CONTOH EVIEWS - (eA\2016\mydata\contoh eviewsanfl) | = || B |[s23]
[ViewIProchbjectl [SavelFreezeIDetailsﬂ-l [ShowIFetchIStore[DeletelGenrlSamplel
Range: 20002015 — 16 obs Filter: *
Sample: 2000 2015 — 16 obs Order: Name
Bl c
kA eks
kA hrg
% Ir(:;lsd Open 4 as Group

Preview F9 as Equation...

Frar ChrleC as Factor...

Copy Special... 35 VAR...

Paste Ctrl+V 3s System...

Paste Special... as Multiple series

Fetch from DE...

Selanjutnya akan ditampilkan seperti gambar berikut:

[G] Group: UNTITLED Workfile: CONTOHEVI... | = || E ||pEim

[Uiew[P'mcIDbject] [PrintLName Freeze | Default e ISnrt Edi
EKS | HRG KURS |

2000 2678.8 248 .48 5.65 Y
2001 4065.3 33148 10.23
2002 g431.4 G41.88 13.50
2002 15718.0 100.80 13.84
2004 118591.0 536.69 12 66
2008 93497 33225 13.98
2006 14561.0 657 .60 15.69
2007 20148.0 928.10 16.62
2008 26776.0 1085.50 18.96
2009 43501.0 191220 2205
2010 49223.0 243580 2250
2011 G5076.0 G936.70 20.60
2012 54941.0 37314 43.00
2013 58087.0 2107.70 T0.67
2014 112871.0 283570 71.20
2015 108280.0 3235.80 a4.00
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Untuk menyimpan Group klik tab Name dan berinama akan ditampilkan

windows seperti terlihat di bawah ini:

Object Mame >

Mame to identify object

- 24 characters maximum, 16
Al or fewer recommended

Display name for labeling tables and graphs (optional)

Cancel

Klik OK untuk menyimpan
Sampai disini proses persiapan telah selesai dan data telah siap untuk diolah.
2. Estimasi Model Regresi Linier

Estimasi model pada software EViews mengikuti model/persamaan

matematis yang telah direncanakan sebelumnya, yaitu :

EKS:a"‘ﬂ[X[ -/-ﬂgXZ + &

Estimasi model/persamaan (£quation Estimation) dilakukan dengan cara
memunculkan  jendela Equation  Estimation, lalu menuliskan
persamaan/model yang akan diestimasi dalam jendela Equation Estimation.

Ada beberapa cara untuk melakukannya (disini ditunjukkan 2 cara).

Cara Pertama, bisa dengan cara klik Quick => Equation Estimation, maka

akan muncul tampilan sebagai berikut:
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¥ Biews
File Edit Object View Proc mOptions Add-ins Window
Command Sample..

Generate Series..,
E] Command Show .
Graph ..
Empty Group (Edit Series)

Series Statistics ’
Group Statistics b
Estimate Equation...

Estimate VAR...

Equation Estimation x

Spedification  Options

Equation spedfication
Dependent variable followed by list of regressors induding ARMA
and POL terms, OR an explidt equation ke Y=c(1) +c(2)™X.

eks chrg kurs

Estimation settings

Method: |5 - |east Squares (NLS and ARMA) W

Sample: [ 2000 2015

Lalu akan muncul jendela Equation Estimation yang terdiri dari 2 (dua)

bagian, Specification dan Option. Pada bagian Specification ada Equation

specification dan Estimation setting.

Pada Equation specification tuliskan semua variabel yang akan dimasukkan

ke dalam model dengan spasi sebagai pemisahnya (tertulis : EKS HRG KURS

C atau EKS C HRG KURS). Variabel terikat selalu paling kiri, setelah itu

variabel bebas dan konstanta/intersep, C. Sedangkan pada Estimation

setting (pastikan) pilihan Method :

Equation Estimaticn
Spedfication  Options

Equation specification

LS — Least Squares (LS and ARMA).

Dependent variable followed by list of regressors including ARMA

--- IL terms, OR an explidt equation like ¥ =c{1) +c{2)®X.

Estimation settings
Method( (|5 - Least Squares (NLS and ARMA)

Sample: | an0p 2015

Cancel
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Cara Kedua, membuka seluruh variabel penelitian dengan cara tahan tombol
Ctrl, lalu klik B8 eks &8 ra gan £ kurs, Setelah itu klik kanan pada mouse,

klik Open => as Equation.

Workfile: LATIHAN EKSPOR - (c\users\user\google drive\1... - B X
[ViewIProcIObject] [SavelFreezeIDetailsff-] [ShowlFetchIStoreIDeletelGeanSampIe]
Range: 19852000 — A6 obs Filter: *
Sample: 1985 2000 — 16 obs Order. Name
Bl c
B eks
A hrg
bA kurs
KA resid Open 4 as Group

B Chrl+C as Equation...

Copy Special... as Factor...

Paste Ctrl+V S

Paste Special... B

as Multiple series

Manage Links & Formulae...
Fetch from DE...

Update from DB...

Store to DB...

Export to file...

Rename...

Delete

< > Untitled ;| New Page |
Lalu akan muncul jendela Equation Estimation yang sama dengan cara

pertama. Seluruh variabel penelitian termasuk konstanta/intersep sudah

tertulis.

Setelah tertulis semua variabel pada bagian Equation specification, klik

sehingga akan menghasilkan output seperti berikut ini :
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rIEI Equation: UNTITLED Workfile: CONTOH EVIEWS:Untitled3\ | = | = ||£i-|-
[ViewlPrncIDbjectl [Printha@elFre%:e] [EstimateIFnrecastIStatisesidsl

Dependent Variable: EKS
Method: Least Squares
Date: 081016 Time: 20:00
Sample: 2000 2015
Included observations: 16

Variable Coefficient Std. Error t-Statistic Frob.

C -4067 496 4584 454  -0.887237 0.3911

HRG 7.815037 1.818575 4297340 0.0009

KURS 1001.855 130.3073 7688406 0.0000
R-squared 0911347 Mean dependentvar 37913.01
Adjusted R-sguared 0897709 35.0. dependentwvar 34949 41
S.E. of regression 11177.88 Akaike info criterion 21.64862
Sum squared resid 1.62E+09 Schwarz criterion 21.79343
Log likelihood -170.1890 Hannan-Qwinn criter. 21.65604
F-statistic G6.81992 Durbin-Watson stat 2161663

Prob(F-statistic) 0.000000

Sampai tahap ini estimasi model regresi linier telah dilakukan.

Sebelum berlanjut ke tahap berikutnya, ada baiknya jendela diberi nama
terlebih dahulu agar tersimpan dalam Workfile. Caranya dengan klik pada
jendela , lalu muncul kotak Object Name. Isikan Name to identify object

dengan nama yang diinginkan..

Object Mame *

Mame to identify object

24 characters maximum, 16

persamaan 1| or fewer recommended

Display name for labeling tables and graphs (optional)

Cancel
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Silahkan ketik nama equation tanpa spasi. Secara default nama diberikan
oleh Eviews eq01, dan angka 01 dibelakang eq akan bertambah pada saat
terjadi penyimpanan data berbeda berikutnya. Pada contoh ini nama

equation adalah persamaan1 (tanpa spasi)

Workfile: CONTOH EVIEWS - (e1\2016\mydata\contoh eviewsawfl) | = | = |[s25s]

[View] PmcIDbjectl [SE\reIFreeze 1 Details—-f-] [ShnwlFetch [ StanIDelete [ GEﬂrISample]

Range: 20002015 — 16 obs Filter: *
Sample: 2000 2015 — 16 obs Order: Mame
[B]

kA eks

[E] group0

kA hrg

kA kurs

[=] persamaani
kA resid

3. Pengujian Asumsi Klasik

Pengujian terhadap asumsi klasik yang akan dilakukan meliputi
multikolinieritas, autokorelasi, normalitas, linieritas dan heteroskedastisitas.
Pengujian dilakukan dengan cara mengaktifkan/membuka jendela Equation:
PERSAMAAN1. Setiap pengujian dilakukan satu per satu. Berikut adalah

tahapan operasionalisasinya :

1) Multikolinieritas
Uji multikolinieritas menggunakan VIF (Variance Inflation Factors).
Caranya, pada jendela Equation: persamaan1 klik View => Coefficient
Diagnostics => Variance Inflation Factors, maka akan muncul tampilan

seperti berikut ini :
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(=] Equation: PERSAMAANT Workfile: LATIHAN EKSPOR... - O X

[ViewlPrnchbject] [PrinthamelFreeze] [EstimateanrecastlStatsIResids]

Representations &
Estimation Cutput
] ] Prob. F(2,13) 0.0315

Actual Fitted, Residual *| Prob. Chi-Square(2) 0.0369

ARMA Structure... Prob. Chi-Square(2) 0.0243

Gradients and Derivatives »

Cowvariance Matrix

Coefficient Diagnostics » Scaled Coefficients

Residual Diagnostics » Confidence Intervals...

Stability Diagnostics » Confidence Ellipse...

Yariance Inflation Factors
Label
Coefficient Variance Decomposition
C 1516.726
HRG 0.162585 Wald Test- Coefficient Restrictions...
KURS 1862848 gitted Variables Test - Likelihood Ratio...

R-squared 04125322 Redundant Variables Test - Likelihood Ratio...
Adjusted R-=quared 0.322153 Factor Breakpoint Test
S.E. of regression 6082.401 e e
Sum squared resid 4 B1E+08 Schwarz criterion 2057641
Log likelinood -160.4524  Hannan-CQuinn criter. 20.43397
F-statistic 4564439 Durbin-Watson stat 1577711
Prob({F-statistic) 0.031506 A

(=] Equation: PERSAMAANT Waorkfile: CONTOH EVIEWS::Untitl...| = || = (s

[ViewlProcIDbjectl [PrintINamelFreezel [EstimateIForecastlStatsIResidsl

Representations

Estimation Output

Actual Fitted, Residual 3
ARMA Structure...
Gradients and Derivatives 3 Std. Errar t =tatistic Prab.

Covariance Matrix

4584 454  -0.887237 0.3911

Coefficient Diagnostics 4 Scaled Coefficients

Residual Diagnostics r Confidence Intervals...

Stability Diagnostics 4 Confidence Ellipse...

Variance Inflation Factors
Label
TOUNTSYUATEUTESTT —— TOZETOE Coefficient Yariance Decomposition

Log likelihood -170.1890
F-statistic 66.81992 Wald Test- Coefficient Restrictions...
Prob(F-statistic) 0.000000

Omitted Variables Test - Likelihcod Ratio...
Redundant Variables Test - Likelihood Ratio...

Factor Breakpoint Test...

Akan dihasilkan seperti terlihat pada gambar berikut:
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2)

r [=] Equation: PERSAMAANT Workfile: CONTOH ... | = || B ||n&s| ﬁ
[‘JiewIPmcIDbject] [PrinthameIFreeze] [EstimatEIFurecastlStatisesi

Wariance Inflation Factors
Diate: 08M0M6 Time: 20:30
Sample: 2000 2015
Included observations: 16

Coeflicient  LUncentered Centered

Variable Variance WVIF WIF

c 21017217 26891338 A
HRG 3307217 2508549 1.248358
KURS 16979.99 3007933 1.248358
\\/,

Hasil uji multikolinieritas, dapat dilihat pada tabel kolom Centered VIF.
Nilai VIF untuk variabel HRG dan KURS sama-sama 1,248. Karena nilai
VIF dari kedua variabel tidak ada yang lebih besar dari 10 atau 5 (banyak
buku yang menyaratkan tidak lebih dari 10, tapi ada juga yang
menyaratkan tidak lebih dari 5) maka dapat dikatakan tidak terjadi

multikolinieritas pada kedua variabel bebas tersebut.

Berdasarkan syarat asumsi klasik regresi linier dengan OLS, maka model
regresi linier yang baik adalah yang terbebas dari adanya
multikolinieritas. Dengan demikian, model di atas telah terbebas dari

adanya multikolinieritas.

Autokorelasi

Data yang digunakan untuk mengestimasi model regresi linier
merupakan data time series maka diperlukan asumsi bebas autokorelasi.
Guna memastikan apakah model regresi linier terbebas dari autokorelasi,
dapat menggunakan metode Brusch-Godfrey atau LM (Lagrange
Multiplier) Test. Caranya, pada jendela Equation: PERSAMAAN1 klik
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View => Residual Diagnostics => Serial Correlation LM Test... , maka

akan muncul tampilan seperti

Specification langsung klik saja)

-

berikut ini : (apabila muncul

(=] Equation: PERSAMAANT Workfile: CONTOH EVIEWS:Un... | = || =) |[w3m]|

[‘u‘iewIPrncl Dbject] [PrintINamEIFreezE] [EstimateIFnrecastIStatsIResids]

Representations

Estimation Output

Actual Fitted, Residual »
ARMA Structure...
Gradients and Derivatives »

Std. Error t-Statistic Praob.

Covariance Matrix

4584454 -0.887237 0.3911
1.818575 4297340 0.0009

Correlogram - O-statistics...
Correlogram Squared Residuals...
Histogram - Mormality Test
Serial Correlation LM Test...
Heteroskedasticity Tests...

-

Coefficient Diagnostics r
Residual Diagnostics 2
Stability Diagnostics k
Label
TOUTTSUdarEUTESy TUECTUT
Log likelihood -170.1890
F-statistic 66.51992
Prob(F-statistic) 0.000000

Akan ditampilkan hasil seperti berikut:

Lag Specification X

Lags toinclude: | F

Cancel

Klik Ok pada Lag Specification Window

Hasilnya sebagai berikut:

Lag
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s o)

(=) Equation: PERSAMAANT Workfile: CONTOH EVIEWS:Untit... | = [ = ||u5m]
[View[P‘rncIDbject] [PrinthameIFreeze] [EstimateIForecastIStatsIResids]

Breusch-Godfrey Serial Correlation LM Test:

F-statistic 1.626916 Prob. F(2,11) 0.2405
Obs*R-squared 3652444 Prob. Chi-Sguare(2) 01610
Test Equation:

Dependent Variable: RESID

Method: Least Squares

Date: 08M0M6 Time: 20:39

Sample: 2000 2015

Included observations: 16

Presample missing value lagged residuals set to zero.

Yariable Coefficient Std. Erraor t-Statistic Prab.
cC 1536.315 4436.555 0.342426 0.7385
HRG 36170049 2666802 1.356310 02022
KURS -335.3532 2237768 -1.498606 01621
RESID-1) -0.450200 0.347401 -1.295910 02215
RESID(-2) -1.052855 0584193 1771908 0.1041

Nilai Prob. F(2,11) # sebesar 0,2405 dapat juga disebut sebagai nilai
probabilitas F hitung. Nilai Prob. F hitung lebih besar dari tingkat alpha
0,05 (5%) sehingga, berdasarkan uji hipotesis, Ho diterima yang artinya
tidak terjadi autokorelasi. Sebaliknya, apabila nilai Prob. F hitung lebih

kecil dari 0,05 maka dapat disimpulkan terjadi autokorelasi.

Selain menggunakan LM T7est, dapat juga menggunakan Durbin-Watson.
Nilai DurbinWatson sudah tertampil pada jendela Equation:
persamaanl yang mana nilainya 2,162. Nilai ini biasa disebut dengan
DW hitung. Nilai ini akan dibandingkan dengan kriteria penerimaan atau
penolakan yang akan dibuat dengan nilai dL dan dU ditentukan
berdasarkan jumlah variabel bebas dalam model regresi (k) dan jumlah
sampelnya (7). Nilai dL dan dU dapat dilihat pada Tabel DW dengan
tingkat signifikansi (erron) 5% (a = 0,05).
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Jumlah variabel bebas : k= 2
Jumlah sampel : n= 16

Durbin-Watson Statistic:

k=1 =2 K'=3 K'=4 K'=5
n d. dU dL dU d. dUu d. dUu dL dU
 GIE W o= s mm s B e e e
T B LG DD N s sesv' deer e e e
B 0N I3 DS 1T DR AIRT e e s e
9 0824 1320 0629 1699 0455 2128 0296 2588 =oeee  —mee-
10 0879 1320 0697 1641 0525 2016 0376 2414 0243 2822
11 0927 1324 0758 1604 0595 1928 0444 2283 0315 2645
12 0971 1331 0812 1579 0658 1864 0512 2177 0380 2506
13 1010 1340 0861 1562 0715 1816 0574 2.094 0444 2390
14 1045 1350 0905 1551 0767 1779 0.632 2030 0505 229
15 1.077 1361 0946 1543 0814 1750 0685 1977 0.562 2220
16 1.106 1371 ().857 1728 0734 1935 0615 2.157
17 1133 1381 1015 1536 0897 1710 0779 1900 0.664 2.104

18 1158 1391 1046 1535 0933 169 0820 1872 0.710 2.060
10 1180 1401 1074 1353% NO0AT 1ARS NRIQ 1R4R N752 2M12

Tabel Durbin-Watson menunjukkan bahwa nilai dL = 0,982 dan nilai dU =
1,539 sehingga dapat ditentukan kriteria terjadi atau tidaknya

autokorelasi seperti terlihat pada gambar di bawah ini.

Autokorelasi  Ragu- Tidak ada ! Ragu- :  Autokorelasi
- positif (i] ragu (il Autokorelasi 4_5([1 ragu -I-:l][ negatif
[ | i | 1 L

1 I
0 0,982 1,539 2,481 3,018 4

Nilai DW hitung sebesar 2,162 lebih besar dari 1,539 dan lebih kecil dari
2,481 yang artinya berada pada daerah tidak ada autokorelasi.

Hasil pengujian autokorelasi dengan menggunakan dua pendekatan
memberikan hasil yang sama, sehingga dapat disimpulkan bahwa bahwa

dalam model regresi linier yang diajukakan tidak menggandung
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autokorelasi. Artinya pemenuhan asumsi klasik model regresi linier telah

terpenuhi.

3) Normalitas
Uji normalitas yang dimaksud dalam asumsi klasik pendekatan OLS
adalah (data) residual yang dibentuk model regresi linier terdistribusi
normal, bukan variabel bebas ataupun variabel terikatnya. Pengujian
terhadap residual terdistribusi normal atau tidak dapat menggunakan
Jarque-Bera Test Caranya, pada jendela Equation: PERSAMAAN1 klik
View => Residual Diagnostics => Histogram — Normality Test, maka

akan muncul tampilan seperti berikut ini :

o

(=] Equation: PERSAMAANT Workfile: CONTOH EVIEWS:Latih... | = || B ||nZ3m|
[‘u‘iewlecIDbject] [PrinthameIFreeze] [EstimateIFnrecastIStatSIRESidS]

Representations

Estimation Cutput

Actual Fitted, Residual r
ARMA Structure...
LErEE T LS Y| Std Emor  tStatistic  Prob.

Covariance Matrix
4534 454  -0.8BT237 0.3811

1.818575 4297340 0.0009

-

Coefficient Diagnostics

Residual Diagnostics J Correlogram - O-statistics...
Stability Diagnostics L Correlogram Sguared Residuals...
Label Histogram - Mormality Test
OO EUETE T TEST  TOZETOE Senal Correlation LM Test...
Log likelihood -170.1890 .
F-statistic 6681992 Heteroskedasticity Tests...
Prob(F-statistic) 0.000000
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Akan menghasilkan seperti terlihat pada gambar berikut:

Series: Residuals
Sample 2000 2015

4 Observations 15
} Mean 3.84e-12
*7 Median -38T.B572

Maximum 22883 78
- Minimum  -25108.38

Std. Dev. 10408.04
Skewness  -0.180738
14 Kurtosis 4280335
Jarque-Bera 1.118586
':'_ | U Probability 0.571338

Keputusan terdistribusi normal tidaknya residual secara sederhana
dengan membandingkan nilai Probabilitas JB (Jarque-Bera) hitung
dengan tingkat alpha 0,05 (5%). Apabila Prob. JB hitung lebih besar dari
0,05 maka dapat disimpulkan bahwa residual terdistribusi normal dan
sebaliknya, apabila nilainya lebih kecil maka tidak cukup bukti untuk
menyatakan bahwa residual terdistribusi normal. Nilai Prob. JB hitung
sebesar 0,5713 > 0,05 sehingga dapat disimpulkan bahwa residual
terdistribusi normal yang artinya asumsi klasik tentang kenormalan telah

dipenubhi.

Linieritas

Linieritas merupakan asumsi awal yang seharusnya ada dalam model
regresi linier. Uji linieritas dapat dengan mudah dilakukan pada regresi
linier sederhana, yaitu membuat scatter diagram dari variabel bebas dan
terikatnya. Apabila scatter diagram menunjukkan bentuk garis lurus maka

dapat dikatakan bahwa asumsi linieritas terpenuhi. Untuk regresi linier
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berganda, pengujian terhadap linieritas dapat menggunakan Ramsey
Reset 7est.

Caranya, pada jendela Equation: persamaan1 klik View => Stability
Diagnostics =>Ramsey RESET Test..., maka akan muncul tampilan
seperti berikut ini : (apabila muncul RESET Specification langsung klik

saja)

[

[=] Equation: PERSAMAANT Workfile CONTOH EVIEWSzLatih... | = || & ||s25s|
[Uiew[PrncIDhject] [PrintINamelFreeze] [EstimatelFnrecastIStatisesids]

Representations

Estimation Cutput

Actual,Fitted, Residual *
ARMA Structure...
LErEE I L " Std Ermor  tStatistic  Prob.

Covariance Matrix
4584 454  -0.887237 0.32911

Coefficient Diagnostics 3 1.818575 4.297340 0.0009
130.3073 7.688406 0.0000

Residual Diagnostics K
Stability Diagnostics J Chow Breakpoint Test...
Label CQuandt-Andrews Breakpoint Test...
TOUTNT SYUATEUTESd —— T.OZCTUs Multiple Breakpoint Test...
Log likelihood -170.1890
F-statistic Go.g1ggy  Cnow Forecast Test..
Prob(F-statistic) 0.000000 Ramsey RESET Test...

Recursive Estirates (OLS only) ...
Leverage Plots...

Influence Statistics...

Akan ditampilkan hasil seperti terlihat di bawah ini:

{RESET Specification X

Mumber of fitted terms: Klik OK

Cancel
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(=] Equation: PERSAMAANT Workfile: CONTOH EVIEWS:Latih... | = || = |[nE|
[‘u‘iewIF‘rncIDbject] [PrinthameIFreeze] [EstimatelFnrecastIStatsIResids]

Ramsey RESET Test ~
Equation: PERSAMAAMA

Specification: EKS C HRG KLURS

Dmitted Variables: Squares of fitted values

P
Value df Probahility
t-statistic 0197712 12 0.8466
F-statistic 0.039090 (1,12) 0.8466
Likelihood ratio 0.052035 1 0.8196
F-test summary:
Sum of 5q. df Mean Sguares
Test 35R 5273914, 1 52T3914.
Restricted S35R 1.62E+09 13 1.25E+08
Unrestricted SSR 1.62E+09 12 1.35E+08
LR test summary:
Value df
Restricted LogL -170.1890 13
nrestricted LogL 1701630 12

LInrestricted Test Equation:

Dependent Variable: EKS

Method: Least Squares

Date: 081016 Time: 22:.01

Sample: 2000 2015

Included observations: 16 W

Apabila nilai Prob. F hitung lebih besar dari tingkat alpha 0,05 (5%) maka
model regresi memenuhi asumsi linieritas dan sebaliknya, apabila nilai
Prob. F hitung lebih kecil dari 0,05 maka dapat model tidak memenuhi
asumsi linieritas. Nilai Prob. F hitung dapat dilihat pada baris F-statistic
kolom Probability. Pada kasus ini nilainya 0,8466 lebih besar dari 0,05
sehingga dapat disimpulkan bahwa model regresi telah memenuhi

asumsi linieritas.

5) Heteroskedastisitas

Heteroskedastisitas terjadi pada saat residual dan nilai prediksi memiliki

korelasi atau pola hubungan. Pola hubungan ini tidak hanya sebatas
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hubungan vyang linier, tetapi dalam pola yang berbeda juga
dimungkinkan. Oleh karena itu ada beberapa metode uji
heteroskedastisitas yang dimiliki oleh EViews, seperti : Breusch-Pagan-
Godfrey, Harvey, Glejser, ARCH, White dan lain-lain. Idealnya semua
metode uji heteroskedastisitas dicoba sehingga kita yakin bahwa tidak

terjadi heteroskedastisitas dalam model regresi linier ini.

Pada kesempatan ini hanya Uji Glejser saja yang disimulasikan (yang lain
prinsipnya sama). Caranya, pada jendela Equation: PERSAMAAN1 klik
View => Residual Diagnostics => Heterosketasticity Test. Pada saat
muncul jendela Heteroskedasticity Test pilih Glejser, lalu klik OK, maka

akan muncul tampilan seperti berikut ini :

-

[=] Equation: PERSAMAANT Workfile: CONTOH EVIEWS:Latih... | = || B |[w5s|
[View[P‘mcIDbject] [PrinthameIFreeze] [EstimateIFnrecastIStatsIRESids]

Representations

Estimation Qutput

Actual Fitted, Residual 3
ARMA Structure...
LETEE I LA M| Std Eror  tStatistic  Prob.

Covanance Matrix
4584 454  -0.887237 03811

1.818575 4.297340 0.0009

-

Coefficient Diagnostics

Residual Diagnostics k Correlogram - C-statistics...
Stability Diagnostics L Correlogram Squared Residuals...
Label Histogram - Mormality Test
TOOTIT EUATETTESIT — TOZCT0E Serial Correlation LM Test...
Log likelihood -170.1890 -
F-statistic 5581992 Heteroskedasticity Tests...

Akan tampil windows Heteroskedasticity Test seperti berikut ini:
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Heteroskedasticity Tests =

Spedfication
Test type:

Breusch-Pagan-Godire Dependent variable: RESID~2

Harwvey

Glejser The Breusch-Pagan-Godfrey Test
ARCH regresses the squared residuals on the
White original regressors by default.

Custom Test Wizard...

Regressors:
C hrg kurs

Add eqguation
regressors

Cancel

Contoh disini akan menggunakan Uji Hetorokedastitas model Glejser.

Berikut hasilnya:

=] Equation: PERSAMAAMNT Workfile: CONTOH EVIEWS:Latih... [ = (=} |ﬁ
[View] Procl Dbjectl [ Print] Name] Freezel [ Estimatel Forecastl Stats ] Resids l

Heteroskedasticity Test: Breusch-Pagan-Godfrey

F-statistic 5291152 Prob. F(213) 0.0z208
Obs*R-squared 7179827 Prob. Chi-Square(2) 0.0276
Scaled explained 53 T.726680 Prob. Chi-Square(2) 0.0210

Test Equation:

Dependent Variable: RESID"Z
Method: Least Squares

Date: 081116 Time: 12:51
Sample: 2000 2015

Included observations: 16

“ariable Coefficient Std. Error t-Statistic Prab.

C -25527145 61925339 -0.573709 0.5760

HRG -9454 614 2456474 -0.384886 0.7065

KURS 5390893, 1760149, 3062747 0.0091
R-squared 0.4487389 Mean dependentvar 1.02E+08
Adjusted R-squared 0.363930 S.D. dependentwvar 1.89E+08
S E. of regression 1.51E+08 Akaike info criterion 40 67065
Sum squared resid 2 96E+1T7 Schwarz criterion 40 81551
Log likelinood -322 36582 Hannan-Quinn criter. 40 67807
F-statistic 5.291152 Durbin-Watson stat 1746724

Prob(F-statistic) 0020836
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Keputusan terjadi atau tidaknya heteroskedastisitas pada model regresi
linier adalah dengan melihat Nilai Prob. F-statistic (F hitung). Apabila nilai
Prob. F hitung lebih besar dari tingkat alpha 0,05 (5%) maka Ho diterima
yang artinya tidak terjadi heteroskedastisitas, sedangkan apabila nilai
Prob. F hitung lebih kecil dari dari tingkat alpha 0,05 (5%) maka Ho ditolak
yang artinya terjadi heteroskedastisitas.

Nilai Prob. F hitung sebesar 0,0315 lebih kecil dari tingkat alpha 0,05 (5%)
sehingga, berdasarkan uji hipotesis, Ho ditolak yang artinya terjadi
heteroskedastisitas.

Dari kelima uji asumsi klasik ternyata model yang diestimasi tidak
memenuhi persyaratan terbebas dari heteroskedastisitas oleh karena itu
diperlukan “penyembuhan” terhadap model regresi linier yang akan
digunakan. Guna memenuhi asumsi terbebas dari heteroskedastisitas
salah satu cara yang dapat digunakan adalah melakukan transformasi
model dari model linier menjadi log-linier. Berikut bentuk persamaan
(model) log-linier:

Ln(EKS) =a+ ﬂ]l_n(X]) +ﬂ2 Ln(XZ) + &

Model regresi yang ditawarkan awal (tanpa log didepan variabel) biasa
juga disebut dengan model linier, sedangkan persamaan di atas disebut
dengan model log-linier. Karena model yang akan diestimasi berubah
maka kita mengulang langkah 2) Estimasi model Regresi dan 3)
Pengujian Asumsi Klasik.

Cara meng-estimasinya model secara umum sama dengan yang telah
dijelaskan di atas, hanya saja pada saat menuliskan persamaan, di depan
variabel yang ada /n-nya dituliskan /og dan berikan tanda kurung pada
variabelnya.

Klik Quick => Equation Estimation. Pada jendela Equation Estimation
bagian Equation specification ketik log(EKS) C log(HRG) log(KURS) lalu
klik, sehingga akan mucul tampilan sebagai berikut:
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Equation Estimation X ]
! [=] Equation: UNTITLED Workfile: CONTOH EVIEWS::Latihar | = || =) [[s3]

Specification  Options [view [Proc| Object [ [Print [ Name | Freeze | [Estimate | Farecast stats | Resids|
Equation spedfication Dependent Variable: LOG(EKS)
Dependent variable followed by list of regressors induding ARMA Method: Least Squares
and PDL terms, OR an explicit equation like ¥ =c{1)+c{2)*X. Date: 08/1116 Time: 19:58

Sample: 2000 2015

[ |og(eks) C |og(hrg) |og(kurs) ] Included observations: 16

Variable Coefficient Std. Errar t-Satistic Prab
C 4766007 0.633428 7.524138 0.0000
LOG{HRG) 0.387640 0.129981 2982283 0.0106
LOG(KURS) 0.856986 0.197379 4341827 0.0008
R — R-squared 0281384 Mean dependent var 10.07000
Methed: |5 - Least Squares (LS and ARMA) v Adjusted R-sguared 0.863136 S.D. dependentvar 1.083597
et S.E ofregression 0.400879  Akaike info criterion 1177045
* | 2000 2015 Sum squared resid 2.089149 Schwarz criterion 1.321906
Laog likelihood -6.416363 Hannan-Quinn criter. 1184463
F-statistic 48.29880 Durbin-Watson stat 1.670846
Prob(F-statistic) 0.0000071

Corce

Seteleh model diestimasi, beri nama dengan Persamaan2. Sampai tahap
ini model telah selesai diestimasi dan tahap selanjutnya pengujian asumsi
klasik.

Pengujian terhadap asumsi klasik yang dilakukan pada persamaan2 sama
seperti pada persamaan1, yaitu: multikolinieritas, autokorelasi, normalitas,
linieritas dan heteroskedastisitas. Pengujian dilakukan dengan cara
mengaktifkan/membuka jendela Equation: persamaan2. Adapun hasil
dari masing-masing pengujian adalah sebagai berikut:

1) Multikolinieritas

[‘u‘iewlProcIDbject] [PrintINameIFreeze] [EstimatelForecastI Stats[Resids]

Variance Inflation Factars
Date: 081116 Time: 20:03
Sample: 2000 2015
Included observations: 16

Coefficient  Uncentered Centered
Variable Variance WIF WIF
C 0401231 3894741 A
LOGIHRG) 0.016895 8271924 2081316
LOGKURS) 0.0335859 38.33686 2081316

Nilai VIF dari kedua variabel hanya 2,08 maka dapat dikatakan tidak

terjadi multikolinieritas pada kedua variabel bebas tersebut.
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2) Autokorelasi

(=) Equation: UNTITLED Workfile: CONTOH EVIEWS::Latihan, = E=N <
[View]Prochbject] [Print]Name[Freeze] [Estimate[Forecast[Stats[Residsl
d Breusch-Godfrey Serial Correlation LM Test: ~
F-statistic 0.869639 Prob. F(2,11) 0.4460
Obs*R-sguared 2184460 Prob. Chi-Square(2) 0.3355
N

Test Equation:

Dependent Variable: RESID

Method: Least Squares

Date: 081116 Time: 20:07

Sample; 2000 2015

Included observations: 16

Presample missing value lagged residuals setto zero.

Nilai Prob. F hitung sebesar 0,4460 lebih besar dari tingkat alpha 0,05
sehingga dapat disimpulkan tidak terjadi autokorelasi. Kalaupun harus
menggunakan uji Durbin-Watson hasilnya pun sama yaitu tidak

terjadi autokorelasi.

3) Normalitas

(=] Equation: UNTITLED Workfile: CONTOH EVIEWS:Latihan\ =n o ==
[ViewIProclObjectl [PrinthameIFreeze] [EstimateIForecastIStatsIResidsl

Series: Residuals
Sample 2000 2015
Observations 16

4 Wezn -7.18=-18

Median -0.024288
a4 Macdimum 10.858540
Minirnism -0 698222
Std. Dev. 0.373158
9 Skewness 0287542
Hurtosis 3. 283087

JargqueBera  0.28881T
T Probability  0.875195
475 -5 025 [ilas) 025 050 avrs 1.00

Nilai Probabilitas JB (Jarque-Bera) hitung lebih besar dari 0,05 maka

dapat disimpulkan bahwa residual terdistribusi normal.

4) Linieritas

Modul Praktikum Eviews 9

|g
|



FIEI Equation: UNTITLED Woarkfile: CONTOH EVIEWS:Latihan', |- B | S|
[ViewlPrncIDbject] [PrinthameIFreeze] [EstimateIFnrecastIStatisesids]

Ramsey RESET Test “
Equation: UNTITLED

Specification: LOG(EKS) C LOG(HRG) LOG(KURS)

Omitted Variables: Squares of fitted values

Value of Probability )
t-statistic 0.675260 12 0.5123
F-statistic 0.455976 1,12) 0.5123
Likelihood ratio 0596702 1 0.4398
F-test summary:

Sum of 5q. df Mean Sguares

Test 35R 0076478 1 0.076478
Restricted 35R 20891449 13 0160704
Unrestricted SSR 2012672 12 0167723
LR test summary:

Value df
Restricted LogL -6.416363 13
nrestricted LoglL -6.118012 12

Nilai Prob. F hitung 0,8466 lebih besar dari 0,05 sehingga dapat

disimpulkan bahwa model regresi telah memenuhi asumesi linieritas.

5) Heterokedastisitas
Uji Heteroskedastisitas menggunakan beberapa uji dengan hasil

sebagai berikut: Breusch-Pagan-Godfrey
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(=] Equation: UNTITLED Workfile: CONTOH EVIEWS::Latihan, =0 =
[View[Proc]Dbjectl [Print]NameIFreezel [EstimateIForecastIStats]Resids]
(Heternskedasticiw Test Breusch-Pagan-Godfrey ~
F-statistic 3149253 Prob. F(2,13) 0.0767
Obs*R-squared 5221964 Prob. Chi-Square(2) 0.0735
Scaled explained 35 3900749 Prob. Chi-Square(2) 01422
NG
Test Equation:
Dependent Variable: RESID"2
Method: Least Squares
Date: 081116 Time: 20016
Sample: 2000 2015
Included observations: 16
Variable Coefficient Std. Errar t-Statistic Frob.
C 0200124 0.282606 2.831452 0.0142
LOG(HRG) -0.131965 0.057991 -2.275592 0.0404
LOGEURS) 0.079835 0.088061 0.9065849 0.3311
R-squared 0326373 Mean dependentvar 0.130572 v
AAdinetnd O cmnAaraAd N3 Ta0 oM AnnanAant uar [aReTakeleT~3u]

Pada tahap ini boleh digunakan lebih dari satu seperti : Glejser, White,
ARCH, Harvey.

Nilai Prob. dari F hitung dan Chi-Square hitung lebih besar dari
tingkat alpha 0,05 maka dapat disimpulkan tidak terjadi

heteroskedastisitas pada model persamaan?2.

Semua uji asumsi klasik pada Persamaan2 (model log-linier) telah
terpenuhi, sehingga model tersebut lebih layak digunakan untuk

menjelaskan pengaruh variable bebas HRG dan KURS terhadap EKS.

6) Uji Kelayakan Model
Diingatkan kembali bahwa model yang akan digunakan adalah

sebagai berikut:

Ln(EKS) =a-+ ,B;Ln(X;) +ﬂ2 Ln(XZ) + &

Hasil estimasi output EViews 8 adalah sebagai berikut :
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(=] Equation: UNTITLED Workfile: CONTOH EVIEWS:Latihan, =0 =R

[‘Jiew[ProcIDbject] [PrinthameIFreezel [Estimate[ForecastIStatslResids]

Dependent Variable: LOG(EKS)
Method: Least Squares

Date: 081116 Time: 1958
Sample: 2000 2015

Included observations: 16

Variable Coefficient Std. Error t-Statistic Prob.
C 4. 766001 0.633428 T7.524138 0.0000
LOGHRG) 0387640 0129981 2982283 001086
LOGKURS) 0.856986 0197379 4341827 0.0008
R-squared 0.881384 Mean dependentvar 10.07000
Adjusted R-squared 0863136 S.D. dependentvar 1.083597
3.E. of regression 0.40087Y9 Akaike info criterion 1177045
Sum squared resid 2089149 Schwarz criterion 1.321906
Log likelihood -6.416363 Hannan-Quinn criter. 1.184463
F-statistic 43 29880 Durbin-Watson stat 1670846
ProbiF-statistic) 0.000001

i. Uji F (Kelayakan Model)

Uji keterandalan model atau uji kelayakan model atau yang
lebih populer disebut sebagai uji F (uji simultan) merupakan
tahapan awal mengidentifikasi model regresi yang diestimasi
layak atau tidak. Layak (andal) disini maksudnya adalah model
yang diestimasi layak digunakan untuk menjelaskan pengaruh
variabel-variabel bebas terhadap variabel terikat. Nama uji ini
disebut sebagai uji F, karena mengikuti mengikuti distribusi F
yang kriteria pengujiannya seperti One Way Anova.

Pengunaan software memudahkan penarikan kesimpulan alam
uji ini. Apabila nilai prob. F hitung lebih kecil dari tingkat
kesalahan/error (alpha) 0,05 (yang telah ditentukan) maka
dapat dikatakan bahwa model regresi yang diestimasi layak,

sedangkan apabila nilai prob. F hitung lebih besar dari tingkat
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kesalahan 0,05 maka dapat dikatakan bahwa model regresi
yang diestimasi tidak layak.

Hasil uji F dapat dilihat pada tabel di atas. Nilai prob. F
(Statistic) sebesar 0,000001 lebih kecil dari tingkat signifikansi
0,05 sehingga dapat disimpulkan bahwa model regresi yang
diestimasi layak digunakan untuk menjelaskan pengaruh Harga
Ekspor Garment (HRG) dan Kurs Yen terhadap Rupiah (KURS)
terhadap variabel terikat Ekspor Garment (EKS).

S

Uji t (Uji Koefisien Regresi)

Uji t dalam regresi linier berganda dimaksudkan untuk menguiji
apakah parameter (koefisien regresi dan konstanta) yang
diduga untuk mengestimasi persamaan/model regresi linier
berganda sudah merupakan parameter yang tepat atau belum.
Maksud tepat disini adalah parameter tersebut mampu
menjelaskan perilaku variabel bebas dalam mempengaruhi
variabel terikatnya. Parameter yang diestimasi dalam regresi
linier meliputi intersep (konstanta) dan slope (koefisien dalam
persamaan linier). Pada bagian ini, uji t difokuskan pada
parameter slope (koefisien regresi) saja. Jadi uji t yang
dimaksud adalah uji koefisien regresi.

Hasil uji t dapat dilihat pada tabel di atas. Apabila nilai prob. t
hitung (ditunjukkan pada Prob.) lebih kecil dari tingkat
kesalahan (alpha) 0,05 (yang telah ditentukan) maka dapat
dikatakan bahwa variabel bebas berpengaruh signifikan
terhadap variabel terikatnya, sedangkan apabila nilai prob. t

hitung lebih besar dari tingkat kesalahan 0,05 maka dapat
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dikatakan bahwa variabel bebas tidak berpengaruh signifikan
terhadap variabel terikatnya.

Nilai prob. t hitung dari variabel bebas log(HRG) sebesar
0,0106 yang lebih kecil dari 0,05 sehingga variabel bebas
log(HRG) berpengaruh signifikan terhadap variabel terikat
log(EKS) pada alpha 5% atau dengan kata lain, Harga Ekspor
Garment berpengaruh signifikan terhadap Ekspor Garment
pada taraf keyakinan 95%. Sama halnya dengan pengaruh
variabel bebas log(KURS) terhadap variabel terikat log(EKS),
karena nilai prob. t hitung (0,0008) yang lebih kecil dari 0,05
sehingga dapat dikatakan bahwa variabel bebas log(KURS)
berpengaruh signifikan terhadap variabel terikat log(EKS) pada
alpha 5% atau dengan kata lain, Nilai Kurs Yen terhadap
Rupiah berpengaruh signifikan terhadap Ekspor Garment pada
taraf keyakinan 95%.

Koefisien Determinasi

Koefisien determinasi menjelaskan variasi pengaruh variabel-
variabel bebas terhadap variabel terikatnya. Atau dapat pula
dikatakan sebagai proporsi pengaruh seluruh variable bebas
terhadap variabel terikat. Nilai koefisien determinasi dapat
diukur oleh nilai RSquare atau Adjusted R-Square. R-Square
digunakan pada saat variabel bebas hanya 1 saja (biasa disebut
dengan Regresi Linier Sederhana), sedangkan Adjusted R-
Square digunakan pada saat variabel bebas lebih dari satu.
Dalam menghitung nilai koefisien determinasi penulis lebih

senang menggunakan R-Square daripada Adjusted R-Square,
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walaupun variabel bebas lebih dari satu.

Nilai R-Square pada tabel di atas besarnya 0,8814
menunjukkan bahwa proporsi pengaruh variabel log(HRG) dan
log(KURS) terhadap variabel log(EKS) sebesar 88,14%. Artinya,
Harga Ekspor Garment dan Nilai Tukar Yen terhadap Rupiah
memiliki proporsi pengaruh terhadap Ekspor Garment sebesar
88,14% sedangkan sisanya 11,86% (100% - 88,14%)
dipengaruhi oleh variabel lain yang tidak ada didalam model

regresi.

7) Interpretasi
Setelah estimasi model regresi linier berganda dilakukan dan diuji
pemenuhan syaratnya (uji asumsi klasik) serta kelayakan modelnya,
maka tahap terakhir adalah menginterpretasikannya. Interpretasi atau
penafsiran atau penjelasan atas suatu model yang dihasilkan
seharusnya dilakukan setelah semua tahapan (uji asumsi klasik dan
kelayakan model) dilakukan. Mengapa demikian? Pertama, karena uji
asumsi klasik memastikan bahwa persyaratan minimal sebuah model
regresi linier (dengan pendekatan OLS) telah dipenuhi sehingga tidak
akan menimbulkan kesalahan dalam pemenuhan asumsi. Apabila uji
asumsi klasik belum terpenuhi besar kemungkinan interpretasi model
menjadi bias atau kurang tepat. Kedua, uji kelayakan memastikan
bahwa model regresi linier yang diestimasi memang layak
menjelaskan pengaruh variabel bebas terhadap variabel terikat.
Apabila model yang diestimasi tidak atau kurang layak, maka model
tersebut memang tidak bisa digunakan untuk menafsirkan

(interpretasi) pengaruh variabel bebas terhadap variabel terikat.
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Interpretasi yang dilakukan terhadap koefisien regresi meliputi dua
hal, tanda dan besaran. Tanda menunjukkan arah hubungan. Tanda
dapat bernilai positif atau negatif. Positif menunjukkan pengaruh
yang searah antara variabel bebas terhadap variabel terikat,

sedangkan negatif menunjukkan pengaruh yang berlawanan arah.

Searah maksudnya adalah, apabila variabel bebas mengalami
kenaikan/peningkatan/bertambah maka variabel terikat akan
mengalami  hal yang sama kenaikan/peningkatan/bertambah.
Sedangkan apabila variabel bebas mengalami
penurunan/pengurangan maka akan berdampak kepada variabel

terikat yang akan mengalami penurunan/pengurangan juga.

Berlawan arah maksudnya apabila variabel bebas mengalami
kenaikan/peningkatan/bertambah maka variabel terikat akan
mengalami hal yang sebaliknya yaitu penurunan/pengurangan.
Sebaliknya, apabila variabel bebas mengalami
penurunan/pengurangan maka variabel terikat akan mengalami

peningkatan/bertambah.

Besaran menjelaskan nominal slope persamaan regresi. Penjelasan
tentang besaran dilakukan pada contoh model yang diestimasi.
Perhatikan model (persamaan) regresi log-linier yang telah diestimasi

di bawah ini:
Ln(EKS) =a + g/Ln(X;) + B-Ln(X;) +&
Angka-angka yang tertera pada persamaan diambil dari tabel estimasi

output persaman2. Koefisien regresi untuk variabel In(HRG) sebesar

0,3876 dan variabel In(KURS) sebesar 0,8570.
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Koefisien regresi In(HRG) bernilai positif artinya pada saat
pertumbuhan Harga Ekspor Garment ke Jepang (HRG) naik maka
persentase Ekspor Garment ke Jepang (EKS) juga akan mengalami
kenaikan. Begitu pula pada saat persentase harganya turun maka
persentase ekspornya juga turun. Kenaikan Harga Ekspor Garment (ke
Jepang) sebesar 1 persen akan meningkatkan pertumbuhan Ekspor
Garment (ke Jepang) sebesar 0,3876 persen dan sebaliknya,
penuruhan Harga Ekspor Garment (ke Jepang) sebesar 1 persen akan
menurunkan persentase Ekspor Garment (ke Jepang) sebesar 0,3876

persen.

Koefisien regresi In(KURS) bernilai positif memiliki arti yang sama
dengan koefisien regresi In(HRG). Pada saat Nilai Kurs Yen terhadap
Rupiah (KURS) menguat maka jumlah Ekspor Garment ke Jepang
(EKS) akan mengalami peningkatan. Begitu pula pada saat Kurs Yen
melemah terhadap Rupiah maka jumlah ekspornya juga menurun.
Pertumbuhan Nilai Kurs Yen sebesar 1 persen akan meningkatkan
persentase Ekspor Garment (ke Jepang) sebesar 0,8570 persen dan
sebaliknya, penuruhan Kurs Yen sebesar 1 persen akan menurunkan

persentase Ekspor Garment (ke Jepang) sebesar 0,8570 persen.

Sebagai catatan, tidak semua model regresi linier yang dibentuk
dapat diinterpretasikan dari sisi besaran. Hal ini bergantung kepada
satuan dari variabel penelitian itu sendiri. Sebagai contoh data
penelitian yang menggunakan data primer & kuesioner sebagai alat
ukur variabelnya (biasanya menggunakan skala Linkert) tidak dapat

diinterpretasikan dari sisi besaran, hanya dari sisi arah saja. Hal ini
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dikarenakan skala Linkert tidak memiliki satuan, hanya menunjukkan

gradasi (perubahan) nilai dari kecil ke besar, tidak suka ke suka, tidak

setuju ke setuju, dan lain-lain. Apabila diinterpretasikan (dijelaskan)

dari sisi besaran, maka satuan apa yang tepat untuk skala Linkert.
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